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Copyright Notice 
 Visual Scheduling Systems Pty Ltd. All rights reserved. No 
part of this publication or the software itself may be 
reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language in any form by any 
means without the written permission of Visual Scheduling 
Systems Pty Ltd, 51 Carinya Road Picnic Point Sydney NSW 
2213 Australia +(612) 9792 7021. 

 

Terms and Conditions 
The information in this manual has been carefully checked and 
is believed to be accurate. However, Visual Scheduling 
Systems assumes no responsibility for any inaccuracies that 
may be contained therein. In the interests of continued product 
development, Visual Scheduling Systems reserves the right to 
make improvements in this manual and the products it 
describes, at any time, without notice or obligation. Information 
on the latest product developments for the Visual Classroom 
Scheduler are available from Visual Scheduling Systems. 
Please call or write for information. 
 

Disclaimer 
The interpretation of the displays, results, listings or indicators 
given by the Visual Classroom Scheduler is entirely at the 
discretion and risk of the purchaser and user. In no event will 
Visual Scheduling Systems, its management, staff or 
distributors be liable for direct, indirect, special, incidental, or 
consequential damages resulting from any defect or omission 
in this manual, or the products described, or helpful 
suggestions given, even if advised of the possibilities of such 
damage. Trademarks such as IBM, Excel, are the property of 
their respective companies or owners.  
The Visual Classroom Scheduler needs an IBM compatible 
Pentium, Windows or Mac OS10 personal computer. 
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1.1.1.1.    Introduction Introduction Introduction Introduction     

Congratulations on your purchase of the Visual Classroom 

Scheduler! 

How can the Visual Classroom Scheduler help 

you? 
 

The Visual Classroom Scheduler aims to provide: 

 

.  A simple solution to schedule/timetable design problems. 

 

.  Relief from time consuming effort and not altogether 

 satisfactory results. 

 

.  A package effective enough to resolve timetabling worries 

 arising from day to day problems such as sickness, 

 maintenance problems and minor emergencies. 

 

.  Visual information and a wide range of reports to help 

 manage valuable resources. 

 

. Confidence that the schedules made will work from day one 

and deliver expected outcomes with a minimum of fuss. 
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Benefits 
 

The Visual Classroom Scheduler delivers: 

 

• Faster schedule/timetable design with less rework caused 

by double bookings, over commitments and under utilisation 

of resources. 

 

• Increased satisfaction of Teachers / Instructors, Students, 

Senior Head Teachers / Instructors and administration staff 

where timetables are clear and easy to update, swaps are easy 

to arrange and each person can have their own printed copy 

or access to view  their timetable on screen. 

 

• Lower costs where teacher / instructor hours can be easily 

balanced between appropriate teachers / instructors, incorrect 

subject or room allocations corrected and room usage 

maximised to allow allocation of extra classes. 

 

• Less student confusion and improved satisfaction along 

with higher student retention rates. Each student can be 

issued with their own printed group timetable in their first 

week of term. The best facilities are more readily available, 

and classes arranged to compress attendance days and reduce 

room changes to a minimum.   

 

• Improved budget and productivity performance as VCS 

on-screen statistics and unique reporting features promote 

productivity and performance improvements.  
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How is it different? 
 

The Visual Classroom Scheduler is a schedule/timetable design tool, 

not just a data collection and reporting tool. 

 

It clearly shows scheduling opportunities and clashes during 

schedule design. It speeds up the whole process dramatically without 

unnecessary double bookings, or under/over commitments. 

 

It is a tool effective enough to continually help solve day to day 

problems such as: 

 

• Finding available rooms for new courses 

• Deciding suitable/available teacher or instructor 

absence/replacement; 

• One off room usage needs; 

• Preparing accurate teacher / instructor time sheets; 

• Advising students of class times and arranging staff meetings. 

 

The Visual Classroom Scheduler saves effort for the designer, 

produces a better result, and can also provide information to a 

variety of interested groups. 

Some quotes from clients who have used the system include; 

• "A perfect solution with some excellent timesaving features." 

• "For minimising data entry, the Visual Classroom Scheduler is 

second to none!" 

• "The planner is superb on this package." 
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2.2.2.2.    InstallationInstallationInstallationInstallation    
 

Our first step today will be installing the program onto our 
computers from the VSS web-site or from CD. 
 

 

 
1. Please follow the instructions at the VSS web 

site at http://www.vss.com.au. or on the CD 
pack. 

2. When you have down loaded or located the 
VCSinstall.exe file and double clicked on it the 
installation screen below will appear.  

 
 

 

 
 

Click [Next] to contine 
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Please follow the prompts and accept all questions, license 

agreements and default suggestions.  

 

The installation includes the java environment or “JVM”, the VCS 

program, help files, demo file and sample .txt masterfiles for 

courses, subjects, rooms and instructors.  

 
 

 

 

Click [Next] to contine 
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The installation normally loads program files to the Windows 

Program Files directory – unless you choose otherwise. 
 

 

 
Click [Next] to contine 
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The default program group is Visual Classroom Scheduler. 
 

 

 

 

Click [Next] to contine 
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Now all the choices have been made the installation can begin. 

  

 

 
Click [Next] to contine 
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Demo and masterfiles are copied to the C:\VSS directory. 
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VCS has been successfully installed. 
 

 

 
Installation Complete click [Finish]  
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To start the Visual Classroom Scheduler: 

 

Click on the Windows [Start] button at the bottom left side of the 

screen. 

 

Select [Programs] and a list of available programs will appear. 

 

Select [Visual Classroom Scheduler] and click on the [VCS] tab. 

 

The VCS program will now begin to load and after a few seconds the 

VCS splash screen below will appear.  
 

 

 
 

A few more seconds later the main VCS screen will appear.  

 

If you are using the demo program, the demo file will automatically 

load.   



VISUAL CLASSROOM SCHEDULER   

USER MANUAL   
_______________________________________________________________ 

____________________________________________________ 

13 

3.3.3.3.    Before You StBefore You StBefore You StBefore You Start...art...art...art...    

The MENU - how can it help me? 

The menu bar is displayed at the top of the screen. It provides 

 you with a selection of functions:  

 

Each function allows access to a pull-down menu. 
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How do I use the MENU? 

To access the menu functions, press [ALT and the character] , or use 

your mouse to click on the menu you wish to select. This will 

display a pull down list of functions. 

These functions can also be selected by typing the character in 

brackets, or again using the mouse. 

Selections can also be made with the arrow direction key 

highlighting the function required and pressing Enter. 
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What are the Functions on the MENU? 

File 

These functions allow you to create brand new schedules (files), 

open existing schedules, save schedules to disk, print to a printer or 

disk file, and exit the Visual Classroom Scheduler. 
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The File menu contains the following functions: 

New creates a brand new 

schedule file. This function 

presents you with a blank 

grid on your screen with 

the name UNTITLED.VSS 

as the file name. The 

program invites you to give 

the new file a new name. 

The new file name will 

then be shown in the top 

left side of the screen. 

Open opens an existing .vss data 

file. Data files can be 

merged using the Visual 

1000 and 3000 models by 

simply opening the next 

file. Also opens tab-

delimited text files 

exported or saved from 

VCS.  

Save saves the schedule to disk.  

The Visual Classroom 

Scheduler will prompt you 

to save the data file when 

changes have been 

detected. Current screen 

settings are also saved for 

re-display next time.  
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Save As saves a schedule to a new 

file name or as a text file. 

You can duplicate an 

existing schedule to a new 

name and modify one 

version whilst keeping the 

other unchanged. 

Write Back Campus models V1000 and 

V3000 can recreate merged 

and updated section files. 

This function writes files to 

be given back to sections after 

consolidation and adjustments 

for clashes and priorities at 

Campus level.  

Remove allows removal of a section's 

activities from the Campus 

file. Typically prior to re-

merging of new activities 

from that section. Old records 

cluttering the display can also 

be removed prior to week n. 

Print prints the schedule to a local 

or LAN printer, or to a disk 

file for later reading and 

printing by your word 

processor / Internet browser. 
Several types of print can be 
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selected here - eg timetables,  

timetable listings, one page 

prints and reprints and view 

prints. Also Costed Summary 

reports on total schedule 

teaching hours, SCH, 

overtime, class sizes and 

matching room capacities is 

available. Use the [no border] 

option for higher speed on 

Postscript laser printers. 

Export  provides for the down 

  loading of VSS data to a 

"TAB delimited" text file 

readily accepted by 

spreadsheet and database 

programs. See Hints and 

Tips for further details and 

instructions. A new weekly 

spreadsheet shows hours 

per week and Teaching 

budget totals and costs. 
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Import  this function reads in or 

opens "TAB delimited" text 

files originally “exported” 

from VCS. This allows 

update in a spreadsheet and 

return to VCS.  

EXit allows exit back to 

Windows. Requests update 

of schedule details to file if 

changes have been 

detected. 
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Edit 

These functions allow you to edit or CHANGE a schedule by 

adding, deleting, moving, and copying information within the 

schedule or searching for specific details.  

The default is Update mode (the safest).  
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The Edit menu contains the following functions: 

Add  enters a new activity onto an 

existing timetable. Enter 

details such as the room 

name, teachers or instructors 

name, class name, subject, 

day and start and finish times.  

Entry details are optional – 

leave some blank and 

“update” them later  - or use 

drag and drop to allocate. The 

dialog will continue to restart 

for a new entry until [Cancel] 

is selected. 

 NB. You can quickly input 

multiple resources from 

masterfiles. This can be found 

under the FastEntry on this 

Menu.  

(U)pdate allows correction or changes 

to existing activities or row 

names in the schedule in all 

model sizes. 

 Just click on the activity to 

update. Or drag and drop to a 

new row name or day. Safer 

than “copy” or “delete” mode 

so VCS defaults to ‘update” . 
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(M)ove moves information within the 

schedule. This allows you to 

"click, drag and drop" 

activities and move them. 

Whilst working in this mode 

the moved activity can appear 

in a new color to allow you to 

see what you've changed.        

A suitable color for added or 

moved schedules is Blue. 

This color change can be 

selected through the Color 

menu, using Add/Move. 

Copy  duplicates activities or rows 

within the schedule. Using 

this function allows quick 

duplication of information 

down or across a timetable, 

saving time on repeated input. 

 To reverse the copy in 

progress, simply press ESC 

whilst holding your finger 

down on the mouse button. 
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Delete deletes activities or rows 

within the schedule using 

the mouse to identify 

activities to be deleted.  

 Only works in “All Weeks” 

view to avoid mistakes.  

Search searches for information 

within the whole schedule. 

Highlights the activites by 

colour or blimking etc.. 

FastEntry allows you to input 

multiple resource names eg 

10 teachers or instructors,  

5 rooms etc, one after the 

other - and speeds up the 

whole data entry process. 

Also has an [mf] button to 

obtain names and details 

from text masterfiles in 

your C:\VSS directory.  

The masterfile setup details 

are on the web site at 

http://www.vss.com.au/mas

terfile.asp 
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SEttings Settings that can be modified include: 
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Expected Normal Teaching Hours / week 

 Used to calculate any excess after the time given.  

After hours Teacher/Instructor Overtime rate 

 Insert a value to suit your Campus. eg 

250 = 25% loading after 5:30pm and Saturdays. (Ask VCS to make 

options for your teaching award) 

Target Room Utilisation.  

 Used to calculate percentage actual room usage vs a 

target room usage, eg 50 hours/week . 

12 or 24 Hour Format 

 Displays and prints times in the format selected. 12 

shows AM and PM, 24 shows army time eg 13:20. 

Default Starting Semester Week Number  

 Choose a starting week for classes from the 

calendar icon and then click [Set Week] or type the 

week number into the box.  

Default End Semester Week Number  

 Type the number for the last logical week of 

semester eg 18 or 20. This saves typing the same 

week numbers over and over when adding classes. 

Default Starting Calendar Week Number  

 Choose the starting week for the year from the 

calendar icon and click [Set Week] to align VCS 

week numbers with your local calendar.  
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Term Breaks (when using annual week numbers) 

 Input start and end calendar weeks of the term 

breaks. Normal semester class activities will not 

occur in these weeks. However, if you schedule 

activities using those week numbers, eg Summer 

school, your  activities will be shown and counted.  

Public Holidays  

 Input calendar week number and day when holiday 

occurs. Activities will not be shown or counted 

there unless scheduled using that week and day 

number. 

Display and Print Options 

O - Show Calendar Week (Wk # on display and prints) 

O – Show Semester Week (Good for schedulers) 

O – Show Date display (Best - date + semester week # ) 

 

Bookings  

 Highly recommended to have this 

as your default. 

 Bookings is a point and click 

reservation (booking) system. 

 Click on the grid where you want 

a class and VCS prompts for 

booking details at the point 

clicked. It also defaults the day 

and resource name selected.  
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 Note – uses :”update” mode and 

so any activity clicked begins the 

update prompts for that activity. 

Note that weeks used are in 

accord with week number or "all" 

on the screen.  

 Handy function to have on all the 

time. 
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Typical “update” or “booking” dialog. 

Note fields are optional except start and finish time, day and begin 

and end week. 

[mf] buttons access text masterfiles in the C:\VSS directory for each 

name. Update your own details in these files. 
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 View 
 

This menu allows you to look at your schedule in four 

different ways.  

All views are integrated with all other views! 

You can view rooms, teachers / instructors, subjects or 

classes. You can also change the time span or the number of 

levels or rows you are viewing,  or break the view into time 

periods. This menu also allows selection of timelock, 

patterns, week number on display (or all weeks) and 

statistics functions. 
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The View menu consists of the following functions: 

Rooms displays rooms and their teachers, 

subjects and classes. The room 

names are listed down the left of 

the screen in the Names column 

and all information relevant to the 

rooms is visible, accessible and 

changeable. Update the left hand 

names column to change the 

name, cost or room capacity. 

Teachers / InstrucTors / LecTurer 

 displays teachers / instructors and 

their rooms, subjects, and classes. 

Teacher or instructor names are 

listed down the left of the screen 

in the Names column. Update the 

left hand Names column to 

change the name, FT salary, PT 

cost/hr or Faculty name. 

Subjects  displays subjects and their rooms, 

teachers / instructors and classes. 

Subject names are listed down the 

left of the screen. in the Names 

column. Update the left hand 

names column to change the 

name,  Students expected  or 

Faculty name. 
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Classes displays class groups and their 

rooms, teachers or instructors and 

subjects. Class groups are listed 

down the left of the screen in the 

Names column. Update the left 

hand names column to change the 

name, input $fees, number of 

students or Faculty name. 

TimespaN  changes the schedule display to a 

selected time span, eg one day to 

seven days. Use the arrow 

direction keys to scroll from 

Monday to Tuesday and so on. 

Specify the usual length of the 

day ie. 08:00 - 22:00 for a more 

effective use of the viewing area. 

Masterfiles  shows details of the VCS 

room.txt, instructor.txt, class.txt 

and subject.txt  masterfiles stored 

in your VSS directory. Create 

your own campus masterfiles and 
then double click here to auto 

select any entry into your section 

schedule. 

 Levels/Rows  changes the number of levels (or 

rows) displayed. The default is 10 

which allows comfortable 

viewing, however a large number 

of  levels can be selected. This 
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allows the full display of a large 

schedule with say 40  teachers / 

instructors, subjects or classes, or 

condenses the screen for part of a 

smaller schedule. The maximum 

number of levels recommended 

for ease of viewing per page is 

20, as the horizontal lines help to 

differentiate each row. Any 

number over this displays a more 

condensed view without these 

lines. 

PAtterns provides a very large number of 

color and pattern combinations 

used to identify or differentiate 

activities in a large schedule. The 

standard number of color 

combinations is 14. These can be 

seen by selecting Color, 

Background. 

StatIstics provides interactive statistics on 

rooms, teachers / instructors, 

subjects and classes, providing 

three distinct groups within each 

of these areas and giving the total 

number, the total hours and an 

average.  It also provides the 

number of double bookings and 

percentage used for rooms, and 

double bookings and overtime for 
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teachers / instructors. Double 

bookings are not included in the 

resource totals. Use the icon or 

F4. 
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Week/All allows selection of any week 

number in the schedule period to 

view or print. "All" can also be 

selected to display and print all 

the week's schedule activities 

together. The week number or 

"All" is displayed in the day-of 

the week headings and in report 

headings. When in “Week/All” 

view just arrow right or left to 

scroll across the weeks. 

 

Everyname selecting to view “everyname” 

will show the names of all 

teachers / instructors that are 

instructing within the semester, 

even though the specific week 

that you are viewing may not 

include any instruction hours for 

them. This function can be turned 

“on” or “off”, and the screen 

view as well as listings will alter 

accordingly. If “on” then all 

teachers names will be listed, if 

“off” only those teaching within 

the period displayed on screen 

will be shown or printed. 



VISUAL CLASSROOM SCHEDULER   

USER MANUAL   
_______________________________________________________________ 

____________________________________________________ 

35 

Colors 

This function allows you to select from up to 66,000 background 

colors, and to highlight added or moved schedules, to make the same 

room, teacher / instructor, subject, class or faculty group the same 

color and to show "period" colors for am, pm and evening classes. 

Statistics color highlights good, average or poor usage of resources. 

The current color selection is shown on the menu bar - 

 eg Color = Periods. 
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The Color menu shows the following color functions. 

 

 

Background allows you to select or change 

the background color of the 

display. 

 This is really a question of  

using the colors to suit the 
job. You may want all 
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Agriculture class schedules to 

have a green background, and 

all Mathematics to be in pale 

blue. Or simply to suit your 

own taste! 

Add/move allows you to select or change 

the color of  added or moved 

activities. This is very handy 

to highlight the added or 

moved activities, or make 

them stand out from 

unchanged areas as you are 

working. Select the number 

"0" (Black) to de-activate the 

Add/Move color. 

Rando(M)  sets the color selection to a 

random series of contrasting 

colors. Each activity of the 

schedule is given a new color 

to differentiate them from the 
others.  

Rooms displays each room in a 

distinct color within a 

schedule. Handy when 

"viewing" Teachers / 

Instructors to see home rooms 

for Teachers / Instructors. 
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Teacher / InstrucTors / LecTurers 

 displays each teacher / instructor 

in a distinct color within a 

schedule. Handy when 

"viewing" Rooms to swap 

Teachers / Instructors into home 

rooms. Or when viewing Class 

groups or Subjects to check 

teacher / instructor allocations. 

Subjects  displays each subject in a 

distinct color within a schedule. 

Handy when "viewing" Rooms 

or Teachers / Instructors - so that 

appropriate subjects can be 

easily allocated or checked. 

Classes  displays each class in a distinct 

color within a schedule. Handy 

when viewing rooms to swap 

classes into home rooms for 

teachers / instructors or classes. 

Periods displays activities in different 

colors for the three periods of 

morning, afternoon or evening. 

Handy to spot gaps for potential 

classes. Handy to check 

allocation of evening classes into 

evening time periods. 
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Faculty displays each Faculty group in a 

distinct color. Displays the file 

name of the group in the top 

right hand corner of the screen.  

StatIstics Color comparison of student 

numbers input Vs room capacity 

or recommended subject 

student/teacher (instructor) ratio.               

Red is < 25%, Light Red is < 

50%, Mauve is < 90%, Green is 

good, Blue is > capacity, White 

indicates no comparison data is 

available.  
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Help 

The Help menu is divided into the following functions: 

Help 

The Visual Classroom Scheduler has help screens which can be 

accessed by selecting the Help menu using the mouse or by pressing 

[ALT-H] or F1 function key. Step through the Help screens by 

pressing enter, selecting a menu number or using the down Arrow 

key or up Arrow key to retrace your steps 

 

 

. 
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About selecting About will show 

you the version number of the 
Visual Classroom Scheduler 
that you are working on, the 

registration details and the 

VSS company address and 

phone number.  

 It also shows the number of  

activities and FastEntry items 

in your current schedule on 

the bottom status line. This 

may be handy when working 

close to the limit of your VSS 

model. 

 NB The Visual 1000 saves 

1000 activities, the Visual 
250 saves 250, and so on. A 

warning will be given as the 

limit is approached. 
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Exit 

This function allows for an exit from the Visual Classroom 

Scheduler and an opportunity to save any changes you may have 

made before exiting. 

 

 

 

Exit selecting exit will bring up a 

message asking you if you 

wish to save the selected file. 

 A message will acknowledge 

how many activities have 

been saved to diskette. 

  You will then be asked to hit 

any key to exit the Scheduler. 
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4.4.4.4.    Hints anHints anHints anHints and Tipsd Tipsd Tipsd Tips    
 

Getting off to the right start using the Visual Classroom Scheduler 

means finding the best time saving techniques. Read the Hints and 

Tips and then work through the example exercises in the Step-by-

Step Instructions chapter. 

This will give you the knowledge you need for any timetabling or 

scheduling situation. 
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File 

When you use the mouse to click on the File menu button, a list of 

available functions will automatically appear.  

To select a function, click on the name or type in the character 

underlined in the Name eg [N].  � 

Opening a new schedule using the File function,   

Click the File menu or press [ALT-F] and then select New [N]   � 

The text will show you the file name of  untitled.VSS 

Click File and Save and the system will prompt for a new filename 

and directory. 

Change the name to suit and the new file name will appear at the top 

left hand side of your screen. 

NOTE If the new file name you type is not concluded by a full stop 

the system will automatically give the filename the .VSS extension. 

Input of information into a new schedule can be  

line by line  Click Edit and Add 

eg room, teacher / instructor, class, subject, start and finish time, OR 

multiple entry Click Eit and FastEntry  

eg many teachers/instructor , classes, subjects Also see Edit Tips. 



VISUAL CLASSROOM SCHEDULER   

USER MANUAL   
_______________________________________________________________ 

____________________________________________________ 

45 

 

Opening an existing schedule using the file function is easy. 

Just click the File menu button and either 

Select a previous file from the list of file names displayed using the 

mouse or by typing [1], [2] , [3], or [4]. 

Or 

Select Open from the list, or type [O]  to open � 

Input or search for the required schedule name and Press Enter 

The schedule requested will now appear on your screen. 

HINT:  File names can also be selected by typing the number 

relative to the position of the file name display eg 1, 2, 3 or 4. 

NOTE To merge or consolidate files together, use a Visual model 

1000 or 3000  and File, Open the first data file and then File, Open 

the next file and so on. Each time a file is opened VSS will ask "Do 

you wish to merge these classes/activities with the previous 

activities? (Y)/N.  Type [Y] to merge. 

HINT: Data files merged and saved with the V1000/3000 models 

may contain all classes in an area, building or campus. Any other 

Visual model can then be used to read the merged files for a 

complete picture of accommodation in their surrounding area. See 

File, Remove to delete a merged file from the display. 
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To Save a schedule using the file function  

Just press [Alt-F] and then the S key � The details will be saved 

to the file name shown at the top left of your screen.  

 

NOTE:  If you exit the system when a file has been changed the 

Visual Classroom Scheduler will recommend saving the file. Save 

the file and then Exit. All screen settings and colors will also be 

saved to be reset when the file is next opened.  

If you have not altered the display in any way, VSS will not 

recommend saving the file and exit quickly. 

 

To Save a schedule to a new filename  press the [Alt-F]  key and 

then select SaveAs      � 

HINT When some of a schedule is changing but you need to keep 

the original file intact, you can duplicate it (using Save As). This 

saves double keying the same information. Simply input the new 

information and move it around using the Edit function. 

NOTE: After using this function the new filename is shown on the 

top left of the screen, and this means you are now using the new file 

not the original!!  To continue using the original use the File Open 

functions. 
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To Write changes back to a departmental file when you’ve been 

making changes to the merged Campus file simply type [Alt-F]  and 

type [W], or click on File and select Writeback.  

Select the faculty (department) name and click on OK. VCS will 

write back all classes with the Faculty name chosen to a new file in 

the VSS directory. The filename will be the same as the faculty name 

with a .VSS extension. 

 

To Remove a department’s file from a Campus file type [Alt-F] 

and type [R] or click on File and select R. Key in the faculty name 

and VSS deletes the selected file activities from the display. This 

function allows a more up to date department file to be re-merged 

after removal of the old details from the display.  

In addition, old records (prior to the week given) can also be 

removed by entering OLDRECS. Enter the old week number and all 

old activities will be removed from the schedule display and file. 

Printing schedules makes it all worth while! 

You can print one set for teachers/ instructors, one to put on the 

classroom doors, one to pin up for class groups, and one in daily 

sequence for general use that day. 

Type [Alt-F] and type [P] or click on File and select Print.  � 

You have menus to select the type of report format you require eg. 

Timetable, Listing, Costed Summary, View report (similar to 

what is shown on the screen), Weekly Spreadsheet.  
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Af ter selecting a report, further options are available to sort them in 

Room, Teacher / Instructor, Subject, Class, or Daily sequence. 

Type [R] or select Room to receive a report in alphabetical Room 

name sequence, or [T] to select a report in alphabetical Teacher/ 

Instructor name sequence etc. Sometimes it's handy if the surnames 

are first, so that display and prints are in surname sequence (eg 

MAGUIRE, C).  

Reports can be printed for one week or all weeks, and options are 
provided to print all teacher names etc or only those resources active 

in the week selected. (saves a lot of blanks).  

Postscript pinters print faster if the “No borders” option is selected. 

 

HINT  Use a colour printer for your final prints for noticeboards 

and room doors for stunning timetables. 

 

HINT  Once you have previewed your printout,  to produce .HTM 

files for Internet or Intranet use, use the Print, SaveAs selection 

instead of the Print Print selection. VCS will prompt for a file name 

and location (eg C:\VSS) and create an attractive .HTM output. This 

file needs to be loaded to your fileserver along with the header.jpg 

Details on how to personalise your .HTM file with your own header 

/ banner are included at http://www.vss.com.au/header.asp 
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Exporting VSS data to a spreadsheet or database program is as 

simple as selecting File and then the Export function.  

Type [Alt-F] and type [E] or click on File and select Export.  � 

This downloads the data to a "TAB delimited" text file suitable for 

input to spreadsheets or database packages.  

 

Importing text data to VCS is as simple as selecting File and then 

the Import function.  

Type [Alt-F] and type [I] or click on File and select Import.  � 

This function will request a filename to load  in a "TAB delimited" 

text file format. The columns must be in the same format as the 

“export” file columns.  

 

Tip: Exported data can be exported to a spreadsheet, modified and 

then re-imported back into VCS. Keep the column formatting and 

make sure the file is saved again as a “tab delimited” format. 

If VCS cannot import the new file, use your spreadsheet program to 

resave it as a “tab delimited” type and import again.  

VCS will accept all your changes so be sure to use the correct 

spelling etc. – or update them in VCS later. 
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Edit 

To Add activities to a schedule using the Edit function  

Click the Edit menu or press [ALT-E] and then select Add [A]   � 

OR use the + icon on the tool bar. 

The “Add Activity” dialog appears and allows you to input new 

activities, one by one. Click [Cancel] to stop adding activities. 

Most of the following details are optional, you can put some in later: 

     • Class group  

     •••• Subject name 

     ••••Room number 

     ••••Teacher / Instructor / Lecturer 

     ••••Start time 

     ••••Finish time 

     ••••Start day 

     ••••Roll Number 

     ••••Student Numbers 

     ••••Faculty name 

     ••••Week Begin 

     ••••Week End 

Once you click [OK], a new activity will appear on the screen and 

the dialog box is recycled ready for the next entry. Click [Cancel] to 

finish up and resort the entries.   
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HINT: As you set up a schedule or as you work on changing an 

existing schedule the Visual Classroom Scheduler helps you to 

notice if you've double booked teachers / instructors or classes 

by creating a sunken cell for any overlapping times. Use the 

mouse to move double bookings vertically to available rows.  

Also the columns on the right of the screen headed "Hours" and 

"%Used" show the total hours allocated and the percentage of the 

room allocation, when on Room view, and the total 

teacher/instructor hours using the overtime/ penalty  rates of 

teacher/instructor hours for "after hours" work when on the Teacher 

/ Instructor  view. 

NOTE: The system will warn you when your schedule is 5 activities 

away from the limit for saving a file for your model size 

ie  Visual 250 saves 250, Visual 1000 saves 1000 activities per file, 

This will allow you to save the file before recommencing and 

opening a new file for the remainder of the exercise. 

If you consistently find this warning you would be advised to 

upgrade to a larger capacity model eg  VCS1000,  VCS3000 etc 
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Updating an activity or a row in “Update” or “Booking” mode. 

Click the Edit menu or press [ALT-E] and then select Booking [B] 

Now you can update an activity by simply clicking on the colored 

rectangle with the mouse. The “Update Activity” dialog appears and 

any details can be amended or updated. Most details are optional. 

OR Click on the row name to update the row details for all 

activities at once. In "room' view, the room capacity can be entered 

and in "class" view the number of students and $fees. In "subject" 

view the nominal student complement and $costs. In “Teacher” the 

load and salary or $rate.  

Capacity numbers appear in the zoom window or in the right hand 

column display under "Nos" and in the spreadsheet output.  Try 

Color, StatIstics to check for white activities which indicate missing 

number data.  

Costs appear in statistics and Costed Summary Prints. 

Faculty changes re-allocate activities to the nominated scheduler. 

Tip: Input room, subject and load capacities before timetabling as 

they will speed your work. Best to update them on the text 

masterfiles in C:\VSS eg room.txt, class.txt, subject.txt, instructor.txt  

Input student numbers and $fees after enrollment to reveal true costs 

and Student Contact Hour details.  

HINT: Updating costs, capacities and $fees is really easy – just 

click on the name window, and the unexpected is often 

revealed. Some classes are very costly to run – and some 

unexpectedly inexpensive. Some things help meet your targets 

and budgets and others drag you down.   
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Tip:  Costs and Budgetting 

VCS is more than just a clever timetabling tool that helps you 
allocate effectively and reveals more room capacity. 

The schedule drives the teaching budget. What you schedule drives 

your budget. Extra classes require extra teaching staff. How much 

can you schedule? One extra full time class oftens needs one extra 

full time teacher at $salary!  

HINT: Try clicking on one of the Instructor names and entering 

some details. Enter $40,000 for the salary, loading of 1, select Full 

Time click [OK]. Didn’t take long eh! All salaries could be updated 

in say 15 minutes. Now your schedule is costed for teaching costs! 

Press F4 or View Statistics to see  total teaching costs. The Costed 

Summary report for Teaching staff would also be interesting! 

NB casual rate per hour can be entered instead of a salary. 

Teaching loads can be 0.5 for half a week person etc.  

NOW!! Trying clicking on a room name. Enter 30 for room 

capacity. Stats Type 0  = “My room”, For lecture rooms, enter 

$500 annual cost ($10 week for cleaning, lighting, A/C,  security) 

For computer rooms – enter 50% of the purchase cost for new 

rooms eg $40,000, 25% for one year old eg $20,000 12.5% for 3 

year eg $10,000 and $5,000 for 4 year old rooms. See how that 

impacts the Class Costed Summary report!  

Check View Statistics (F4) and Room Costed Summary Report.   

On a roll now – about to launch into consumables and fees!. 
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Tip:  Costs and Budgetting (continued) 

Hope you can see some interesting information arising. We are about 
to see the unexpected – all calculated for you.  

This will influence the way you plan your educational offerings, the 

staff you employ and the rooms you use. It gives you the information 

to make decisions and persuade others that you need appropriate 

resoures and budget to achieve your goals. 

VCS averages costs per hour of class activity. It then allocates an 

hourly  proportion to each class activity – teaching costs + room 

costs + consumables and compares these with $fees collected per 

class group!  An impossibly complex task manually. 

HINT: Lets try entering consumable costs for each subject. 

Click on a subject name. Enter 30 for subject capacity. Stats Type 0  

= “My faculty subject”, 1 = “another faculty” eg remedial maths. 

If there is a consumable cost or photocopy costs, excursions, 

diskettes, meat or wine costs enter the total figure to run that 

subject once. This is not an annual cost but a running cost. 

Now the last lucky last. 

Lets try entering details for each class or student group.  

Click on a class group name. Enter 28 for number enrolled. Stats 

Type 0  = “State Funded”, eg remedial maths.  

Enter total $fees eg $6,000 for comparison to total costs. 

See the Class Costed Summary Report!  

Try F4 Statistics! Does this raise questions on why some class 

groups cost heaps and others are inexpensive to run?? 
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Moving information within a schedule is simple.  

Click the Edit menu or press [ALT-E] and select Move [M] � 

Position the mouse over the activity of the schedule that you wish to 

move, click and hold down the button and then drag the information 

to the place you want it to be, then release the key. This is referred to 

as click, drag and drop. 

The activity will now appear in the position desired. 

If you wish to cancel while moving an activity, continue to hold 

down the mouse button on the moved activity and press ESC. 

NOTE: A handy Zoom Details Box at the bottom of the screen will 

show in close up, what activity the mouse is positioned over, as well 

as what is scheduled prior to and after the moved activity. 

This is handy for scanning a schedule in order to work further on it. 

HINT: When moving (or copying) activities with the mouse, hold 

down the left mouse button and try ; 

• press 8 for an 8am start, 9 for 9am,  10 for 10am, -  for 11am, = 

for 12am, 1 for 1pm etc.  

• Mid semester, in Teacher/Instructor view, press A for Absent 

teachers/instructors to create an extra activity for the absence 

and allow the class to be moved to another teacher/instructor.  

• Press S to "split" schedule weeks into two halves, or  

• Press T to split into three schedules, one before this week, this 

week only, and one from next week on.  
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• In high school models, press 1 for period 1, and 2 for period 2 

etc and see View Period to set times for periods 0 -9 and lunch 

and recess. 

• using the comma (" ,") key will move an activity five minutes 

back, and the period (".") key five minutes forward, just position 

the mouse buttonover the avctivity at the same time as pressing 

these keys.  

 

TIP: Moving class activities vertically does not change class 

times for Teachers/Instructor, Classes, or Rooms. This is great! 

As you can reschedule to your heart's content without causing 

the usual "domino" effect - ie fix one thing and it produces 

problems elsewhere. Moving class activities vertically is SAFE! 

Note: When moving activities horizontally to a new time and /or 

day, best to check the other views to see if overlaps have occurred 

for another resource eg Teachers/ Instructor, Rooms or Class group. 

If possible, use a vertical move to fix those overlaps without 

affecting other views.  
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TIP: Statistics groupings (Optional) 

Rooms, Teachers/Instructor, Classes and Subjects can be grouped in 

a simple way for display on the statistics display (press F4) or on the 

timetable listings. To group names in the 1st or main group, use 

Statistics Group 0 = “My Rooms”, “Full time instructors”, “My 

Faculty Subjects” or “State Funded Class groups”. 

For a second grouping such as part time teachers/instructors, other 

rooms outside the section or commercial classes, use Stats Type =1. 

For a third "other" grouping, such as maintenance, staff meetings, 

student free access etc, use Stats Type = 3.      

 

Note: Second group (part time) teachers/instructors as specified 

above will not attract any loading calculations for evening or 

Saturday work.  

TIP: Statistics groupings are optional and only affect the 

Statistics screen and loadings for Full time teaching staff after 

hours. Teaching staff groupings are thus recommended. 
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Copying activities or whole rows can be fun! 

Click the Edit menu or press [ALT-E] and select Copy [C] � 

VCS takes a different approach here to many window programs! 

There is no need to hightlight items and then click copy …….... 

Once you are in “Copy Mode”, any item clicked will be copied! So 

be careful – but have fun!  

Try click and hold on the activity, and now while holding, drag it to 

another day and let it go. So once a Monday class is created, it can 

be quickly copied to any other day of the week. Or, if several similar 

class groups are planned, create activities for one group, and then 

copy them to another group – but maybe on different days.  

If the class name is clicked all activities will be copied (and clashed). 

Change to update mode, and click on one activty and change it to a 

new class group name e.g. #2. Then drag clashed activites from the 

original row to make two similar classes. 

Future versions may allow a change of name automatically. 

If you make mistakes – use the Delete Mode and remove them. 

To stop copying – chose another View Mode or just click on any 

menu item. 
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Deleting activities is quick  

Click the Edit menu or press [ALT-E] and select Delete [D] � 

Simply position the mouse over or near the information that you 

wish to delete, and click the button to delete.   � 

You will be asked to confirm the deletion by pressing any key. 

To continue deleting, click on another activity.  

BEWARE there is no Undo facility!  

Best do a save before deleting eh! 

To stop deleting – chose another View Mode or just click on any 

menu item. 

You will be able to quickly rearrange your schedule discarding old 

information in this manner. 

TIP: To delete a whole row - click on the row name and press any 

key to confirm deletion of all the activities.  
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Searching within a schedule is as simple as pressing [ALT-E] and 

then pressing the S key. 

You will be asked to input a name to search on. Only the first few 

letters of the name are necessary. 

Once you have input the name, the Visual Classroom Scheduler will 

search and match the information  and then highlight any occurrence 

of the activity. The Details Box at the bottom of the screen will show 

all the details. Reset the search to turn off the Search function. 

Tip: For larger merged schedules, searches can also be done for 

Faculty names. NB Reset the search to stop the blinking etc. 

 

Using FastEntry to input schedules is great for starting from 

scratch!  Press [ALT-E] and then press the F key. 

You will be asked to enter your selection for entry of all Rooms, 

Teacher / InstrucTors, Subjects or Classes. 

Select, then input all names hitting the Enter key at the end of each 

name. When finished press Enter again to indicate that entry is 
completed. All the names entered will now appear in alphabetic 

sequence.  
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HINT: By inputting names for teachers/ instructors with surname 

first, the Visual Classroom Scheduler will sort the surnames into 

alphabetical order. 

TIP: To see your input make sure that you are in the correct viewing 

mode, eg if you have input Teachers /Instructors first then select 

View and Teacher / InstrucTors to show your input down the left 

hand Names column.  

Note You might also wish to group Part-time (P/T) teachers 

/instructors and classes by including a dash or leading space to sort 

Part/Timers together at the top of the display. Dashes are always 

printed, whereas the space or "P" is not so obvious. Note it is 

recommended that incidental hours are best kept on a separate file.  

TIP: You can select Edit and Update and then click on a activity to 

update (fix) it - OR click on the "names" column text to update (fix) 

ALL the activities in that row! 

HINT: Once you have loaded all the data, you can then arrange the 

schedule by selecting Edit and (M)ove. 

HINT: When updating names and a mistake is made, try ESC and  

the original name will be restored ready for another attempt.  All 

previous entries will be prompted again and all easily reviewed! 
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FastEntry is recommended when starting schedule design from 
scratch. Start with Rooms and then Teachers / Instructors as these 

are "permanent" resources. With Class groups use Course numbers 

plus stage number and a code D1 or E2 for day/evening classes)             

eg 2420 1 D1, and finally Subjects. Use zero duration to avoid 

automatic creation of activities. 

 

To modify the SEttings select [ALT-E] and then the E key. This 
function allows the program to be altered for a variety of uses. 

Note that Initial report headings are normally preset by VSS staff 

prior to despatch, providing the University or Institute name and 

Faculty name on reports and cover screen. 
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Areas that can be modified using this function include: 

 Loading factor TAFE NSW = 250, QLD 500, others 0.  

NSW TAFE  applies a loading factor to full time teachers/instructors 

working after 5:30pm or on Saturdays. 250/1000 = 25% loading. 

 Normal Teaching hours per week - NSW TAFE uses 19 

hours for face to face teaching. Change this number and VSS will 

use the new number to indicate excess hours over the new normal 

working week. eg 20 for SA. 

 Target Room utilisation - TAFE NSW uses a benchmark 

for % utilisation shown on screen and room reports based on 55 

hours per week. The room percentage utilisation shown on screen 

and room reports is calculated by dividing room usage hours by the 

number entered here. 

 Default Schedule Week Begin/End - Begin at week 1 and 

end at 18 etc, or use calendar week numbers or pay week numbers. 

All new schedules will default to this period reducing keystrokes  

 Semester or Term Breaks - If using annual calendar weeks, 

up to three start/end week breaks can be entered to exclude display 

or calculations for schedules across the breaks. eg end Term 1, 2, 3. 

NB Schedules starting or ending in the breaks will still be shown eg 

Summer School.  
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The Booking function is really easy to use.  

Select [ALT-E] and then the B key and then click on the 

screen where you wish to book!  

The function allows the program to assist in booking 

available resources (usually rooms) by 

defaulting a number of details 

including room name (in room view), 

day and start and finish times. 

If the normal prompts are set, the program will still 

request the other details eg teacher, 

subject, class etc to be entered. 

The day is defaulted from the mouse cursor position 

(clicked). 

Press ESC to stop booking this item or click on it to 

update it.  

NB this function also Updates existing items clicked on, 

running through the prompts using the 

current data. 
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View 
 

View is a very friendly feature as it reduces a multi-dimensional 

scheduling problem to simple views where clashes can be resolved 

one at a time. This means the end of the dreaded "domino" effect 

where fixing one clash often causes another and so on. The mouse 

can be used to drag and drop activities into better slots. 

To View  Rooms within a schedule press [ALT-V] and then press 

the R key.   � 

This will display your schedule with the rooms listed down the 

Names column on the left hand side of your screen. 

You can quickly survey the status of all rooms, subjects, classes and 

times, to allow any alterations or additions to be made. 

HINT: Check on rooms that are double booked!  Look along the 

row to see overlapping activity times for this room. Then use the 

mouse to move one of the overlapping activities to a better spot. 

TIP: Moving class activities vertically does not change class 

times for Teachers / Instructors, Classes, or Rooms. This is 

great! as you can reschedule to your heart's content without 

causing the usual "domino" effect - ie fix one thing and it 

produces problems elsewhere. Moving class activities vertically 

is SAFE! 
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Note when moving activities horizontally to a new time and /or day, 
best to check the other views to see if overlaps have occurred for 

another resource eg Teachers / Instructors, Rooms or Class group. If 

possible, use a vertical move to fix those overlaps without affecting 

other views. 

 

To View  Teachers / Instructors within a schedule press [ALT-V] 

and then press the T key. 

This will display your schedule with the teachers / instructors listed 

down the names column on the left hand side of your screen. 

You can quickly survey the status of all teachers / instructors - what 

classes and subjects they are teaching and on what days and at what 

times - to allow any changes that may be required. 

HINT: Check on Teachers / Instructors that are double booked!  

Look along the row to see overlapping activity times for this Teacher 

/, Instructor. Check the Hours column to see total teaching hours on 

class and then use the mouse to move one of the overlapping 

activities to another teacher / instructor or another time of day. 

TIP: Check the Hours column to see the total hours on class. Move 

or update activities to achieve the normal hours for full-time teachers 

/instructors.  
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To View Subjects within a Schedule select [ALT-C] and the S key. 

 

To View Class Groups within a schedule press [ALT-V] and then 

press the C key. � 

This will display your schedule with the Class group names listed 

down the left hand side of your screen. 

HINT: Check on Classes that are double booked!  A warning color 

is used to highlight the double booked name. Look along the row to 

see overlapping activity times for this Class and then use the mouse 

to move one of the overlapping activities to another time of day. 

 

Viewing your schedule over a different Timespan is as simple as 

pressing [ALT-V] and then pressing the N key    � 

You will be asked to input your required time span for viewing the 

Visual Classroom Scheduler. Type in 1 or 2 or 3 ie  from one day to 

seven days on screen. You will also be asked to specify the length of 

day that you wish to view eg 08:00 - 22:00. You can easily view a 

schedule swapping from one day to two or three according to your 

viewing needs. Looking at a schedule on a one day at a time basis 

may allow you to see in greater detail what is taking place on that 

day. 
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HINT Using the arrow buttons on the top right hand side of the 

screen  allows you to scroll through a schedule one week or one day 

at a time. Simply select the Viewing Timespan option of one day and 

then press the arrow pointing to the right hand side� . 

 

The week or day displayed will change to the next day in the 

sequence ie Monday will change to Tuesday. To move back simply 

press the arrow button moving to the left hand side and the 

display will scroll back from Tuesday to Monday. 

 

Viewing your schedule with  period timelines requires pressing 

[ALT-V] and then pressing the P key.   � 

This is for high school models only. 

You will be asked to input your required time interval for timelines 

to be drawn. Type 1 or 24, ie from one hour to twenty four hours. 

This will display your schedule with vertical lines showing the 

selected time periods which can help you to see when schedules 

start. 

eg  the one day display can be divided into one or two hour periods.  

This facility is especially effective at one day time spans with one 

hour periods. 
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To View your schedule with different Levels or Rows just press 

[ALT-V] and then press the L key   � 

You will be asked to input your desired number of levels suggested 

between 10 and 44 rows on screen. 

NOTE: Beyond 40 levels the details become cramped, but the Zoom 

boxes can still reveal the contents of each class and the classes can 

still be moved about - watch the zoom boxes to see where the class 

will be dropped. 

This will display the schedule with horizontal lines showing the 

selected number of rows or levels and may allow viewing of all 

rooms or teachers /instructors or classes at once on the same screen. 

TIP: Use the mouse to see the details of the schedules in the Zoom 

detail boxes below, also use color to highlight Teachers / Instructor 

while viewing Rooms, or color Rooms while viewing Teachers 

/Instructors. 

HINT: The Levels feature is especially useful when moving 

schedules across large groups of teachers / instructors, rooms or 

classes.  

As before, vertical moves are SAFE, as class times are unchanged 

elsewhere.  

As you move, watch the details change in the Zoom Details Boxes 

down below. Watching these details helps position the class activity 

in the row required. 
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VCS Locks the start and finish times of a class using Timelock 

Having the Timelock ON prevents accidental changes to times when 

moving the class to another room or teacher  / instructor , using the 

mouse. Wherever possible rectify problems with the schedule by 

making vertical and NOT HORIZONTAL moves, this avoids the 

dreaded "domino" effect causing clashes in another view of the 

schedule which then also need to be fixed. 

 

Introduce PAtterns in addition to the standard color 

differentiations by using [ALT-V] and then the A key. Using this 

function provides a distinguishing patterns to several thousand room, 
subject, teacher  / instructor or class names. 

 

Interactive StatIstics are available by pressing [ALT-V] and then 

the I key. Three groupings are shown for each view. Double 

bookings are not included in these groups and are totalled separately. 

Groups are set by name group type. 

TIP: Rooms, Teachers  / Instructors, Classes and Subjects can be 

grouped in a simple way for display on the statistics display (select 

View StatIstics or Press F4) or on the timetable listings. To group 

names in the 1st or main group, use group type 0, for 2nd group e.g. 

part time teachers, use group type = 1.  
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For a second grouping such as part time teachers  / instructors, other 

rooms outside the section or commercial classes, use a leading dash 

or space before the name and use group type = 1. Click on the name 

and update the Group Type to equal 1. Using a space or dash prefix  

separates part timers on statistics screens and prints. 

For a third "other" grouping, such as maintenance, staff meetings, 

student free access etc, choose another option and Group Type = 3.  

Note: Part time teachers/ instructors specified as Type 1 will not 

attract any loading calculations for evening or Saturday work. .  

 

To view or print a specific week within the semester or “all” 

weeks simply press [ALT-V] and then the W key. If “all” is selected 

it will be displayed at the top right corner of the screen. Then simply 

arrow right or left to scroll across the weeks 

 

To view or print everyname of teachers or instructors  who are 

teaching within a semester select [ALT-V] and then the E key.  

 

Their names will be displayed even if they are not specifically 

teaching during the specific week shown on your schedule.  
This can be turned “on” or “off” using the ‘every name” function. 
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Colors 
 

Colors are a schedule designer's best friend as they help to fine tune 

and optimise the schedule. 

Changing the Background Color of your schedule is as simple as 

pressing [ALT-C] and then pressing the B key.� 

A color palette showing the various options will appear on your 

screen.  

It's fun to try various background colors by positioning the mouse 

pointer on the color square of your choice and clicking.� 

Alternatively you can select colors using the number shown next to 

the color by keying it in on the keyboard.� 

Our personal preference is a dark grey (select the [Resert] button) 

but....to each their own! 

HINT Selecting and displaying in different colors can simplify 

classifying and filing of schedules . 

 

To highlight Added, Moved or Changed activities in a different 

color press [ALT-C] and then press the A key .� 

Again the color palette will appear and your choice can be made 

with either the mouse or the keyboard.�� 

This makes working on a schedule simple as you can easily see what 

work you've done. When completed, choose any Color, selection to 

reset all colors back to normal. 
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HINT: The recommended color for Added/Moved schedules is Blue 

(Color number 1) as this color contrasts and is particularly effective 

with Color, Periods. All activities of the schedule for example would 

now be colored in light green, light red or mauve  to show morning, 

afternoon or evening classes - and any added or moved schedules 

will be dark blue and totally distinct.  

NOTE If you tire of color changes as you move, add, update and 

copy -  i.e.to stop the add / move color,  reselect Add / Move and 

change the setting to “off”. 

This is the default - and no further changes in color will occur as you 

add, update, and copy. 

 

Random colors give contrast to your adjacent activities and can 

be achieved by pressing [ALT-C] and then pressing the R key.� 

Doing this sets a sequential color number to each activity, so that all 

the available colors are on display. 

Using random colors will add contrast to your activities, and is 

especially useful if a lot of short duration activities (less than 2 

hours) are adjacent to each other.  
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Indicating that you want each Room shown in one color requires 

pressing [ALT-C] and then pressing the R key.� 

Your schedule will now be displayed  with each room in one of the 

available colors. 

This will enable you to readily identify rooms by color even though 

they are scattered over a whole week's schedule. This helps you to 

decide and plan on efficient room use and keep Teachers / 

Instructors in home rooms where possible and keep Class groups in 

the same rooms where possible. Good for fine tuning or optimising! 

 

Requesting that all Teachers / Instructor be shown in one color 

is as simple as pressing [ALT-C] and then pressing the T key.� 

Your schedule will now be displayed with each teacher / instructor 

in one of the available colors.(Press F3 to use patterns to uniquely 

identify 100's of teachers / instructors, rooms, or subjects.) 

This will allow you to identify the teachers / instructors by looking 

for the same color activity without having to switch to View Teacher 

/ InstrucTors mode. Try the Rooms view to check allocation of 

teachers / instructors to "home" rooms, try the subjects view to check 

allocation of teachers / instructors to appropriate subjects. Again this 

helps with the efficiency of planning and editing your schedule. 
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Indicating that you want Subjects shown in one color  means 

pressing [ALT-C] and then pressing the S key.� 

This will display your schedule with each subject shown in one of 

the available  colors.(Press F3 to use patterns.) 

Having this option allows you to identify at a glance all like subjects 

by like colors regardless of the viewing mode. 

TIP: This is most valuable when allocating subjects to rooms or 

teachers / instructors. Just check which room or teacher / instructor 

already has that color allocated already! This is also a very handy 

control mechanism as in View, Room mode, it is easy to check that 

all subjects are in a suitable room.  

The colors readily give them away!  In the View, Teacher / 

InstrucTor mode, it is easy to check that all subjects are allocated to 

suitable Teachers / instructors.  In the View, Classes mode, it is easy 

to see if a subject has been allocated twice to one group or allocated 

incorrectly. 

 

Indicate that you want Classes shown in one color by pressing 

[ALT-C] and then pressing the C key a second time.� 

Having this option allows you to see at a glance all like classes by 

their like colors.  

Handy in View, Room mode to see the movement of class groups 

from room to room to allocate "home" rooms for students, or in 

View, Teacher / InstrucTor mode to see the allocation of classes to 

Teachers  / Instructor. 
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Indicating that you would like to see the Time Periods shown in 

distinct colors press [ALT-C] and then press the P key.� 

Colors will show whether activities commence in morning, 

afternoon or evening time slots. 

ie 0.00am-12.00am   Light Green 

   12.00am-5.30pm  Light Red 

   5.30pm-12.00pm  Mauve 

This allows you to see at a glance how your day is planned and what 

schedule opportunities are available. 

NOTE: To help contrast short class activities starting in the same 

period, a darker shade is used for the second activity. eg dark Green, 

dark Red, or dark Mauve. 

 

To see different Faculty colors select [ALT-C] and the F key. Each 

merged file (or teaching section) will then be shown in it's own color 

with the mouse cursor showing the name in the top right hand corner 

of the screen. The faculty name will be shown in the top right hand 

corner when the mouse is over one of the activities. 

 

To see StatIstics in color select  [ALT-C] and the I key. Colors  

indicates comparisons between student numbers and room capacity 

or recommended subject student/teacher (instructor) ratio. Red is < 

25%, Light Red is < 50%, Mauve is < 90%, Green is good, Blue is > 

capacity, White indicates is no comparison data available (input).  



VISUAL CLASSROOM SCHEDULER   

USER MANUAL   
_______________________________________________________________ 

____________________________________________________ 

77 

 

5.5.5.5.    StepStepStepStep----bybybyby----Step ExercisesStep ExercisesStep ExercisesStep Exercises    
 

This chapter will give you some practice situations which you can 

work through in order to develop your skills in using the Visual C 

Classroom Scheduler. 

This chapter will instruct you through the exercises in a step-by-step 

fashion, showing you as we go through the exercises, how your 

screen should look as we complete each step. 
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Situation  1 - What it will teach you. 

This section helps to familiarise you with the Add function and the 

Copy, and Move functions. This is a fast way to enter an existing 

timetable. 

You will learn to: 

• Set up a schedule, activity by activity using the Edit Add 

function. 

• Use Edit Add to nominate Week numbers, and class sizes or 

Student Numbers.. 

• Correct the errors using the Edit Move function. 

• Look at the schedule in different views using the View menu. 

• Change the Timespan from 1-7 days using View Timespan 

option 

• Show Time Period lines using the View Timeperiods option. 

• Use colors to help with finetuning your schedule. 

• Display your schedule with Morning, Evening and Afternoon 

classes. 
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Starting from WINDOWS 

To input information into the Visual Classroom Scheduler from: 

1.  Access the Visual Classroom Scheduler from Windows  

 by clicking on the Windows [Start] button at the bottom left 

of your screen, 

 selecting [Programs] [Visual Classroom Scheduler][VCS] 

3. The Visual Classroom Scheduler will now load and display 

 the title page. Select File, Open and Demo.VSS to view 

 the sample schedule file Demo.VSS.
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Situation 1 - Getting Started 

You are the Senior Head Teacher / Instructor of your department. 

You have the job of scheduling activities for the next week for 

Classes with the following Subjects. 

Class 8607 D1 

 

Day Start  Finish Room Subject Teacher Wk 

Wed 13.00 16.00 T2.25 

PHOTO LB 

3501PX  

Adv Cont 

LOCKE, 

TONY 

1-18 

Thu  9.00 12.00 G5.17 

LECTURE 

2639A 

Accom S&M 

WHITNEY, 

BRIAN 

1-18 

Thu 13.00 16.00 ?? 3500D 

Sales Mgt 

LOCKE, 

TONY 

1-18 

Fri 14.00 17.00 G3.15 

LECTURE 

3500A 

Mktg Fund 

PHAN, 

KEN 

1-18 
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Class 8607 D2 
 

Day Start  Finish Room Subject Teacher Wk 

Mon 14.00 17.00 G3.15 

LECTURE 

3501PX 

Adv Cont 

LOCKE, 

TONY 

1-18 

Tue 13.00 16.00 G3.15 

LECTURE 

3500A 

Mktg Fund 

?? 1-18 

Thu 14.15 17.15 G5.17 

LECTURE 

2639A 

Accom S&M 

LEE, 

DIANE SNR 

1-18 

Fri  9.00 12.00 G5.18 

LECTURE 

3500D 

Sales Mgt 

PHAN, 

KEN 

1-18 

 

Class 2420 1 D1 

       

Day Start  Finish Room Subject Teacher Wk 

Mon.00 9.00 11.00 G2.16 

Computer Lab 

2481R 

PC Supp 

WHITNEY, 

BRIAN 

1-18 

Tue  9.00 11.00 ?? 2420B 

“C++” 

PHAN, 

KEN 

1-18 

Tue 14.00 17.00 G3.15 

LECTURE 

2420C 

“C++” 

PHAN, 

KEN 

1-18 
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Start up Visual Classroom Scheduler 

Now to open a new file for this week's schedule. 

From the File Menu select New. 
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From the Edit Menu, select Add.  
 

 
 

This will give you a dialog box to fill in,  as seen on the following page. 

 

Please make sure that the CAPS LOCK key on your keyboard is turned on 

for the remainder of this tutorial. 
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The fields you will be filling in are: 

• Class Name 

• Subject Name 

• Room Name 

• Teacher Name 

• Start Time 

• Finish Time 

• Day 

• Number of Students 

 

 

Enter the details in the table below into the correct fields. 

You can leave the other fields blank, or with their initial values. 

 

HINT: You can navigate around the fields with the mouse or with 

the TAB key. 

 

Class 

Name  
Subject 

Name  
Room 

Name  
Teacher 

Name  
Start 

Time  
Finish 

Time  
Day 

No. 

Students  

8607 D1 

3501PX 

ADV 

CONT 

T2.25 

PHOTO 

LAB 

LOCKE, 

TONY 
1:00 

PM 
4:00  

PM 
Wed 30 

 

Check the data in all the fields are correct  
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(remember to always use capitals). 
Press the OK button at the bottom of the dialog box. 

 

The information will be entered into the database, and the timetable 

screen updated.  

You should see this screen for a moment, as the database updates. 

 

Notice the red square which has appeared.  

A few seconds later you will be returned to the dialog box. This 

dialog box contains the data you have just entered. Replace any 

relevant fields with the information below. 

Class 

Name  
Subject 

Name  
Room 

Name  
Teacher 

Name  
Start 

Time  
Finish 

Time  
Day 

No. 

Students  

8607 

D1 

2639A 

ACCOM 

S&M 

G5.17 

LECTURE 
WHITNEY, 

BRIAN 
9:00 

AM 
12:00 

PM 
Thu 30 

 

Continue adding the data in the following tables.  

 

(Please note that there are intentionally some errors (indicated in 

red) and blank fields in this data for the purpose of this tutorial. 

Enter all data as it appears in the fields below). 

 

Class 

Name  
Subject 

Name  
Room 

Name  
Teacher 

Name  
Start 

Time  
Finish 

Time  
Day  

No. 

Students 

8607 

D1 
3500D 

SALES 

T2.25 

PHOTO 

LOCKE, 

TONY 
1:00 

PM 
4:00 

PM 
Wed 30 
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MGT LAB 

8607 

D1 

3500A 

MKTG 

FUND 

G3.15 

LECTURE 
PHAN, KEN 

2:00 

PM 
5:00 

PM 
Fri 30 

8607 

D2 

3501PX 

ADV 

CONT 

G3.15 

LECTURE 
LOCKE, 

TONY 
2:00 

PM 
5:00 

PM 
Mon 30 

8607 

D2 

3500A 

MKTG 

FUND 

G3.15 

LECTURE  
1:00 

PM 
4:00 

PM 
Tue 30 

8607 

D2 

2639A 

ACCOM 

S&M 

G5.17 

LECTURE 
LEE, DIANE 

SNR 
2:15 

PM 
5:15 

PM 
Thu 30 

8607 

D2 

3500D 

SALES 

MGT 

G5.18 

LECTURE 
PHAN, KEN 

9:00 

AM 
12:00 

PM 
Fri 30 

2420 1 

D1 
2481R PC 

SUPP 
G2.16 

COMP LAB 
WHITNEY, 

BRIAN 
9:00 

AM 
11:00 

AM 
Mon 30 

2420 1 

D1 
2420B 

"C++"  PHAN, KEN 
9:00 

AM 
11:00 

AM 
Tue 30 

2420 1 

D1 
2420C 

"C++" 
G3.15 

LECTURE 
PHAN, KEN 

2:00 

PM 
5:00 

PM 
Tue 30 

Hint: Once you have entered a class, subject, room or teacher in a 

record, you can click the arrows next to the field box to select from a 

list of previously entered data in other records. You can do this for 

the time and day fields also. 

 

Once all are complete, press the cancel button on the dialog box.. 
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Your timetable is currently displaying "Room View". You should 

notice that  

• Room names are in alphabetical/numeric order 

• The coloured squares appear to be coloured randomly 

• There are two indented grey cells (on the Tuesday and Wednesday 

columns). These indicate clashes. 

 

Fixing Clashes 
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Two cells are indented. This means that 2 of the rooms or teachers are double 

booked at these times. It's very easy to fix this.  

 

First, Select the Color Menu and then the Periods option. 

 

 

The squares will change to one of two colours, light blue (morning 

classes) and red (afternoon classes). If you had any evening classes, 

these would be shown in mauve. 
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Now select the Edit Menu and then the Update Mode option. By 

positioning the mouse over the duplicated area, the details box at the 

bottom will reflect the details of the activity which you are pointing 

to in the middle box and those occuring on either side in the top and 

bottom boxes. 

You can see that the teacher Tony Locke has two different subjects 

booked on Wednesday for the class group 8607 D1: 

Wed 13:00-16:00 3500D Sales Mgt T2.25 

Wed13:00 -16:00 3501PX Adv Cont T2.25  
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The other clash or duplication is  

Tue 13:00-16:00 3500A Mktg Fund G3.15 

Tue 14:00-17:00 2420C "C++" G3.15 

You can fix the clashes in one of two ways - clicking the square with 

the error and correcting the information in the dialog box which 

appears, or drag-and-dropping the square to a new time or day. 

Click on Tony Locke's Wednesday Sales Mgt Class square and hold 

the mouse button down while you drag it one background rectangle 

to the right (Thursday).  
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Different Ways to View the Timetable 
The first four View Menu options are:  

• Rooms (default view) 

• Teachers 

• Subjects 

• Classes 

Try them out for yourself.  These four views can also be used with other views.  

The Timespan View lets you see a particular time period. In Fig 3.5 

we have chosen Monday to Friday, 9am-5pm, in the Subject View. 
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Working with Color  

 
Color allows the schedule designer to effectively work out a schedule to cater for 

differing and changeable situations.  

• The display of schedules in different background colors helps to sort, file 

and categorise your schedules. 

• Selecting a distinct color for all added, moved or copied schedules also 

makes working on changes simple. 

• The random option will allow you to differentiate easily between small 

activities shown on your schedule. 

• Selecting either rooms, teacher, subjects or classes color will show all 

like names in the same color regardless of the view. 

• Selecting periods will show activities on the schedule in three colors 

indicating morning, afternoon and evening. 

The Color Menu's name will change depending on which Color 

mode you have selected.  
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Background  
Select the Color Menu and then select the Background option. 

Your screen should show this color table. 

 

 
 

To select a color for the screen background, position the mouse on the color you 

want as the background and click. Select one after the other to compare colors. 

Experiment with color as using this function allows quick identification of your 

various schedules. The default background color is Grey (click on the reset 

button).  
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Add/Move  
Now select the Color Menu and the Add/Move option 

Select "On" and press OK. 

Again you are given the option to select the color that you wish added or moved or 

copied schedules to appear in. 

Try picking a color, and creating a new activity 

You will see that as a new activity appears it will be shown in your new color. 

Try moving one of the activities, it will now be shown in your color.  

Select the Color Menu, Add/Move and press "Off" to turn this feature off. 

 

Random  
Now select the Color Menu and the Random Option 

You can see that each activity appearing on the screen has an individual color. 

This allows you to differentiate clearly between each activity. 

  

 

 

 



VISUAL CLASSROOM SCHEDULER   

USER MANUAL   
_______________________________________________________________ 

____________________________________________________ 

95 
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More Color Options  
 

Now select the Color Menu and the Rooms Option. 

You can see that activities appearing in the same room are colored in the same 

color. 

 
 

 
 

If you now swap to a different View you can easily see the activities which are 

relevant to a particular room.  

 

Now select each of the remaining color options and experiment with various views 

of the schedule.  

 



VISUAL CLASSROOM SCHEDULER   

USER MANUAL   
_______________________________________________________________ 

____________________________________________________ 

97 

 

Congratulations ! 

You have now completed Situation 1 and learnt about: 

 

• Setting up a schedule, activity by activity using the File Add 

function. 

• Using Edit Add to nominate week numbers 1-18 

• Using Edit Add to nominate Week numbers, and class sizes or 

Student Numbers. 

• Correcting the errors using the Edit Move function. 

• Looking at the schedule in different views using the View menu. 

• Changing the Timespan from 1-7 days using View Timespan 

option. 

• Showing Time Period lines using the View Timeperiods option. 

• Using colors to help with finetuning your schedule. 

• Displaying your schedule with Morning Evening and Afternoon 

classes. 
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Situation 2  

This section helps to familiarise you with the FastEntry function 

and the Copy, and Move functions. 

This method is recommended when starting a whole new timetable 

from scratch. 

During the exercise you will learn to: 

• Set up a schedule using the Edit FastEntry option. 

• Use Edit Move to arrange your schedule using the drag and drop 

technique and the arrow direction keys. 

• Use the Color menu in conjunction with the View menu to fine-

tune your schedule. 

• Use the Edit Copy function to recreate activities and save input 

time. 
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You are the Senior Head Teacher/ instructor in the Marketing unit. 

You have to organise a schedule for the following Marketing Class 

3500 1 D1, as follows: 

 

Day Start Finish Room Subject Teacher Wk 

Mon 9.00 12.00 G5.18 

LECTURE 

3500D Sales Mgt?? 1-18 

Tue 9.00 12.00 G5.29 

LECTURE 

3500A Mkgt FundWHITNEY,  

BRIAN 

1-18 

Tue 9.00 12.00 -T2.25 

PHOTO LAB 

-5331C 

Photo 

?? 10-18 

Tue 14.00 16.00 G2.16 

486DX33 

2481R PC 

Supp 

LOCKE, 

TONY 

1-18 

Wed 9.00 12.00 -T2.25 

PHOTO LB 

-5331C 

Photo 

LOCKE, 

TONY 

1-18 

Wed 14.00 17.00 G5.17 

LECTURE 

2639A 

ACCOM  

S&M 

?? 1-18 

Thu 13.00 16.00 G3.15 

LECTURE 

3501PX 

Adv Cont 

WHITNEY, 

BRIAN 

1-18 
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Starting Situation 2 

Now to open a new file for this week's schedule. 

Press the File MENU  

Press New (New File) 

Input the filename VISUAL2.VSS. 

We will now load test data  through the Edit Menu and the Fast 

Entry Option. 

Our class is 3500 1 D1 Marketing, and we have 6 subjects over 4 

days, using 6 rooms and 2 teachers to program.  

 

Important Note: 

Ensure the CAPS LOCK key is ON before you proceed. 

This helps standardise input of Teacher / Instructor, Room Subject 

and Class names 
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You are asked to input 

your selection,...(R)oom, (T)eacher, (C)lass, (S)ubject.

 



VISUAL CLASSROOM SCHEDULER   

USER MANUAL   
_______________________________________________________________ 

____________________________________________________ 

102 

Start with Rooms. So enter: 

G5.18 LECTURE 

G5.29 LECTURE 

-T2.25 PHOTO LB 

G2.16 486DX33 

G5.17 LECTURE 

G3.15 LECTURE 

Press ESC or Enter on a blank entry to restart. 

You will need to select Edit Fastentry to enter the next part of 

you schedule, teachers/ instructors 

Now enter Teachers / instructors 

WHITNEY, BRIAN 

LOCKE, TONY 

Press ESC or Enter on a blank entry to restart. 

You will need to select Edit Fastentry to enter the next part of 

you schedule, Class. 

Now enter Class groups 

3500 1 D1 

Press ESC or Enter on a blank entry to restart. 
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Now enter Subjects: 

• 3500D Sales Mgt 

• 3500A Mktg Fund 

• -5331C Photo 

• 2481R PC Supp 

• 2639A ACCOM S&M 

• 3501PX Adv Cont 

(FastType is normally used to speed up Edit, Add entry which does 

not need extra activities created by FastEntry.   

First select Color, Subjects to clearly see the different subjects. 
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Now select View, Rooms to make room allocations. 

Now select the Edit Menu and the Move Option. 

 

Now you can arrange the schedule using the mouse drag and drop 

technique. 

USE PAGE  

Now use the mouse to click and hold each of the colored activities 

while dragging them across and down to an appropriate starting day 

and time and room:  

Move 2481R PC SUPP to 14:00/16:00 TUESDAY and down to 

room G2.16 486DX33. 
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Watch the time box to see 14:00 -16:00 

Careful movement of the mouse is required to set the final 

adjustment - takes a little practice!! Note, by pressing the start time 

whilst still holding the activity with the mouse will adjust it to the 

correct time. 

Now: 

Move -5331C PHOTO to 09:00/12:00   Tuesday and down to room   

-T2.25 PHOTO LB. We need to Copy this activity as it appears 

twice in this weeks schedule. 

The Copy function does a copy and allows drag/drop to a new 

location all at once. A nice feature - a bit tricky till you get the hang 

of it but then it's very useful....... 

NOTE: If you accidentally let go of the mouse button while moving 

the new item into position....don't click again on that activity to 

continue moving it. "Copy" is still operating and will duplicate that 

activity again. 

 

 To fix it, click on the menu bar Edit, (M)ove and then "move" the 

item to the right spot. 

 Click on Edit, Copy to resume. 

Now ESC and select Edit Copy and click on the above activity. 

Copy this activity. Note how the row is duplicated, until you move 

this to the same timeslot on Wednesday. Click on it with the mouse 

and whilst holding down the mouse button press the Right arrow key 

to move the activity to Wednesday. 
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Now re-select Edit (M)ove. 

• Move 2639A ACCOM S&M to 14:00/17:00 Wednesday and 

down to room G5.17 LECTURE 

• Move 3500A MKTG FUND to 9:00/12:00   Tuesday and 

down to room G5.29 LECTURE 

• Move 3500D SALES MGT to 9.00/12.00 Monday and down 

to room G5.18 LECTURE 

• Finally move 3501 PX ADV CONT to 13.00/16.00 Thursday 

and down to room G3.15 LECTURE 

 

Note: For all moves try, whilst holding down the left mouse button, 

using the arrow direction keys to move to the next day and then, still 

holding down the mouse button use the number pad to position the 

activity on the correct time ie 9 = 9am, 10 = 10am etc. 

Now select the View Menu and the Teachers / Instructors Option 

You can see that the activities appear in the first row and the 

teachers' names are listed in the Names column. 

Now select the Edit Menu and the Move Option. 
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Now move the appropriate subject in a vertical movement down to 

the correct teacher, time and day. 

• 3500A MKTG FUND = WHITNEY, BRIAN 

• -5331C PHOTO = LOCKE, TONY  

• 2481R PC SUPP = LOCKE, TONY 

• 3501PX ADV CONT = WHITNEY, BRIAN 
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Again select the  Color Menu and the Subjects Option. 

Now select the  View Menu and the Classes Option. 

Now select the   Edit Menu and the Move Option. 

Go through the same vertical movement and drag and drop all the 

subjects into the class. Day subjects for day classes, evening (and 

some afternoon) subjects for evening classes. 

You have now completed the entry! 

Check the various views - Rooms, Teachers, Classes, Subjects for 

double bookings and under/over commitment indicated by 

duplicated rows and warning text colors (usually yellow). 
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Congratulations ! 

You have now completed Situation 2 and learnt about; 

• Setting up a schedule using the Edit FastEntry option. 

• Using Edit Move to arrange your schedule using the drag and 

drop technique and the arrow direction keys. 

• Using the Color menu in conjunction with the View menu to 

fine-tune your schedule. 

• Using the Edit Copy function to recreate activities and save input 

time. 
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Recommended Setup Method 

Timetables are rarely completely completed from scratch and so a 

combination of the Edit, FastEntry and Edit, Add functions may 

well prove the best way to set up your first schedule. 

Step 1 

• Select File, New to access a blank schedule screen. 

• Use the Edit, FastEntry function to key in all the Rooms, 

then the Teacher Names, Class Groups and Subjects with 

zero duration.  

• Hint for Classes - use Course number, stage number and D 

for day, E for evening eg 2420 1 D1, 2420 1 D2, 8967 2 E1. 

Hint for Subjects use Subject number, and a short name for subject 

name. eg 2420A "C".  

Step 2 

• Use the Edit, Add functions to add each class activity one at 

a time.  

• Notice that FastType finds the teacher name, room name, 

subject name and class group that matches the letters you 

type so only one or two keys are needed to match the whole 

name!  

• Press enter to accept the name supplied or just keep typing. 

Step 3 

• Press File, SaveAs  and enter a new filename to save your 

work. 
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Function Keys 
 

F1Help 

 

Press F1 to bring up the help screen. Also select it through 

the Help menu. 

 

F4 Statistics 

 

See Statistics of Timetable. 
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6666    AppendixAppendixAppendixAppendix    

VCS Training Courses 
 

Level 1 Introductory/Overview 

 

A hands-on session covering most functions of the package, creating 

sample timetables and how to use them for planning and reviewing 

resource usage, or answering enquiries on timetable details and 

printing off listings. 

 

Suitable for all new VSS users, Teaching staff, admin Staff, Campus 

staff including those not computer literate. 

 

For those about to commence serious VSS timetabling and who are 

aware of the basic features, navigation and product potential. Create 

your own timetable with tips tricks and advice on saving time, using 

resource names, and meeting teacher and student preferences. Word 

process output. 

 

Suitable for those starting programming, Teaching staff, Admin 

Staff, Campus Staff. 
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Level 2 Advanced 
 

Suited to staff who have attended level 2 training, allowing full use 

of maximising resource optimisation, statistics, cost savings, 

potential for improved staff satisfaction and consolidation across 

sections. 

Suitable for Teaching staff, Admin Staff, Campus staff. 

 

Level 3 Resource Management 

 

Provides details on usage of consolidated VSS section timetables at 

College/Campus, Institute and Corporate levels. Resource naming 

conventions, Groups, Sub Groups, Types and Sub Types are 

explained along with an implementation approach to achieving 

management goals. Includes an appreciation of Education Planning, 

Resource Management, Room allocation, Human Resources, and 

Finance. Suitable for University, College/Campus, Institute, or 

Central Support management staff. 

 

Level 4 Train the Trainer 

 

Provides a structure for potential VSS trainers at local universities, 

Institutes, Colleges or Campuses. Topics include setting up VSS 

training, conducting hands-on exercises, troubleshooting, and 

making the best of the VSS materials such as manuals, quick 

reference guides, menu maps, and on-line help. answers are provided 

to commonly asked questions, along with training hints and tips. this 

course provides training materials and licences to reproduce training 

materials required. Suitable for Institute or College/Campus trainers 

or teachers.  
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Teaching Budget, Salary And Part Time Costs 
 

Teacher/Instructor Salaries and part time rates of pay can be 

included to cost your Teaching Budget before classes commence! 

Don't wait until students are enrolled and lock in a budget overrun! 

Cost your scheduled plans first, and then be confident that the major 

(variable) portion of your budget is on track and won't blow you out 

of the water!  

 

The VSS Weekly Spreadsheet shows the full semester programmed 

hours and cost for each Teacher/Instructor along with the hours 

planned for each week. 

Full Time is costed by individual salary and part time costed per 

individual hourly rate. Use your on-costed salaries and pay rates to 

get the full flow-on picture. 

 

To enter Salaries and Part time rates of pay into your VSS schedule 

plan:  

• Select the View, InsTructor or Teacher menu to see all your 

 staff on screen,  

• Select Edit, Update from the pull down menu, and  

• Click on the staff members name at the left side of the screen.  

• Note part time staff names should be prefixed by a space, 

dash, or minus sign '-'.  

• Enter the (on-costed) salary eg 44235.00 (no spaces, no 

commas,  no $signs) - or  

• Enter the (on-costed) hourly rate of pay for part time staff. 
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That's it! From now on, all schedule changes can be easily re-costed 

by creating the VSS Weekly Spreadsheet. To create the new costed 

weekly spreadsheet: 

 

• Select File, Excel, from the pull down menu.  

• Choose the Weekly spreadsheet.  

• Enter 'T' to choose Teacher/Instructor spreadsheet.  

• (NB other options are Room, Subject and Class weekly 

spreadsheets)  

• Enter a filename for the spreadsheet eg a:\VSSBUD.XLS  

• Use your favourite spreadsheet program (eg Excel or Lotus 

1,2,3)  to open, format and print the file. 

 

NB VSS creates a Tab-delimited spreadsheet file which can be 

opened and read by all common spreadsheet and database programs, 

including DOS programs, Windows notepad etc. use your favourite 

program - cheers. 

 

Extra Bonus!! Underutilised Full Time hours are shown 

(difference between normal hours and teaching hours scheduled). 

These are the uncosted or unknown hours which impact your budget 

and are now are highlighted in the VSS weekly spreadsheet. You 

will be surprised at the extent of underprogramming and the effect 

on your budget will be obvious! Use VSS drag and drop to re-

allocate staff, - before classes start!  

 

Use VSS to check again, immediately after enrolments, to ensure last 

minute schedule changes have not altered your overall budget 

position. What a relief.  

Happy Budgeting! 
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7777    ConclusionConclusionConclusionConclusion    
 

We thank you for taking the time to use this manual and the other 

aids available to further your education about the Visual Classroom 

Scheduler. 

 

Our established client base speaks for itself in regard to customer 

satisfaction, and we are always interested in hearing your ideas and 

suggestions for improvement. 

 

Contact one of the Visual scheduling Systems friendly staff for any 

additional assistance you require on Tel +(612) 9792 7021. 

 

And don't forget, if you think of someone else who could benefit from 

the Visual Classroom Scheduling package, do them a favour and let 

them know, we'd be happy to help them too! 

 

 
 

This is the last page of the Visual Classroom Scheduler User 

Manual. 

 

Congratulations and well done! 


